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Pass CRT-550 Exam - Real Questions and Answers

Certification Path
Salesforce Marketing Cloud Email Specialist Certification can act as a prerequisite for this exam.

How much CRT-550 Exam Cost
The price of the CRT-550 exam is $200 USD.

How to book the CRT-550 Exam
These are following steps for registering the Salesforce Certified Marketing Cloud Consultant CRT-550 Exam.

Step 1: Visit to Webassessor Exam Registration

Step 2: Signup/Login to Webassessor

Step 3: Select the onsite proctored or online proctored delivery method of Certification Exam

Step 4: Select Date, time and confirm with a payment method

For more information, please click here.
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QUESTION 91

An entertainment company is hosting events across the country in different venues. They want to use Contact Builder to feed

Journey Builder. Contacts who enter a journey will go through a decision split based on the type of event. The journey will send a

series of emails and one of them will contain the venue details dynamically populated with AMPscript.

The company collects the following information:

*Customer data (email address, first name, last name&#8230;.)

*Event registration (email address, event ID, event name, event type, venue ID&#8230;.)

*Venue details (venue ID, venue name, venue address&#8230;.)

*Payment details (email address, event ID, total paid&#8230;.)

The company does NOT want to link everything in Contact Builder. Which two data extensions should be incorporated inside

Contact Builder? Choose 2 answers

*  Event Registration

*  Venue Details

*  Payment Details

*  Customer Data

QUESTION 92

A customer has several values that need to be used in the body of an email send.

* The data would be stored in a reference data extension, related on SubscriberKey

* There may be one or more records for each subscriber

* The audience is generally over 1 million subscribers

* The content is time sensitive and should be sent as quickly as possible

* The customer is not using &#8220;Catch and release&#8221; sending

* The reference data extension contains 25 columns

What method should be used

*  AMPScript a single LookupOrderRows function

*  Dynamic content via the Dynamic content wizard

*  Server side JavaScript a single LookupOrderedRows function

*  AMPScript a single lookup function

QUESTION 93

Which statement IS correct regarding the automation tools in the Marketing Cloud?
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Choose 3 answers

*  Automation Studio and Journey Builder allow users to define a wait state based on duration or duration + time.

*  Automation Studio allows users to inject Contacts from a data extension into an interaction in Journey Builder.

*  Like Journey Builder, Automation Studio allows users to define the parameters for a send within the tool.

*  Journey Builder allows users to update a contact record in an interaction or import data into a data extension.

*  Like Automation Studio, Journey Builder allows users to repeat an interaction indefinitely

QUESTION 94

A consultant is configuring Marketing Cloud Connect in Marketing Cloud. The customer requires that integrated users only have

access to Sales Cloud data visible to them in their Salesforce account.

How would the consultant ensure that this requirement is met?

*  Check the Scope by User box in Marketing Cloud.

*  Create a User in Sales Cloud with a System Administrator Profile.

*  Ensure that the User has the correct profile in Marketing Cloud.

*  Ensure that the User is assigned as System Administrator in Sales Cloud.

QUESTION 95

NTO wants to import files at certain standard times, but occasionally a file will be dropped on a Friday if the 30th of the month falls

on a weekend.

What is the flow?

Triggered Import &#8211; user initiated send (not scheduled)

QUESTION 96

A customer has been having problems with SMS responses getting the default keyword response rather than the appropriate next

keyword response.

What are two potential reasons for this unexpected response?

Choose 2 answers

*  Responses are not sent within 24 hours of the outbound message.

*  Response contained &#8220;stop&#8221; in the message content.

*  Responses are not sent within the Conversation Window.

*  Next keyword was not specified on the outbound message.

QUESTION 97

Northern Trail Outfitters wants to have a periodic, dynamic newsletter send to a set data extension, but the data in this data extension

will be regularly updated and the subscribers inside could be removed/added multiple times.

What option should speed up the delivery while meeting these criteria?

*  Journey that allows re-entry after exiting

*  Scheduled Automation utilizing Triggered Send Emails

*  Scheduled Automation using a Send Activity

*  Single Send Journey
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QUESTION 98

A customer team wants to retarget subscribers who click on links of key items promoted across email campaigns. The customer has

indicated the following:

* Emails will be built using a custom dynamic template for these messages.

* Links will vary over time and across campaigns.

* Click activity will be cross-referenced with subscribers&#8217; regional markets on a master subscriber data extension.

* Retargeting messages will dynamically populate content based on regional market.

In order for this solution to be viable, which skill set does the customer team need to possess?

*  AMPscript

*  SSJS

*  SQL

*  HTML

QUESTION 99

A customer has several values that need to be used in the body of an email send:

* The data would be stored in a reference data extension, related on SubscriberKey.

* There may be one or more records for each subscriber.

* The audience is generally over 1 million subscribers.

* The content is time sensitive and should be sent as quickly as possible.

* The customer is not using &#8220;catch and release&#8221; sending.

* The reference data extension contains 25 columns.

Which method should be used?

*  AMPscript a single Lookup Function

*  Server Side Javascript a single LookupOrderedRows Function

*  AMPscript a single LookupOrderedRows Function

*  Dynamic content via the Dynamic Content Wizard

QUESTION 100

The customer has these requirements for storing engagement data in their data warehouse:

* All email open and click activity must be pulled daily from the Marketing Cloud.

* Output files must meet the specific requirements for the data warehouse.

* All the activity must be provided via FTP in one file.
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Which automation workflow meets the customer requirements?

*  Report activity that generates Recent Send Summary report > Report delivered directly to FTP

*  Extract activity of Tracking Extracts that combines data into required file > Transfer activity

*  Query activity to pull data view information > Extract activity of data extension > Transfer activity

*  Extract activity of data view tables > Query activity to create the required file > Transfer activity

QUESTION 101

Northern Trail Outfitters (NTO) has decided to use Journey builder to launch event-driven lifecycle marketing programs. This

includes personalized interactions with customers with the goal of increasing purchase frequency.

What two pieces of information would help NTO achieve this objective?

Choose 2 answers:

*  Last purchase date

*  Products purchased from a competitor

*  Number of items per order

*  Channel preference of customers

QUESTION 102

A consulting has a data extension that contains all current product information. The customer wants to refresh data each morning by

importing a CSV containing today&#8217;s product catalog. The product catalog is never the same; products can be added and

removed.

Which import type should be used?

*  Overwrite

*  Add Only

*  Add/Update

*  Update Only

QUESTION 103

A customer wants to create a journey with the goal of making users activate their accounts

within 72 h of registration. New account registrations are stored in a data extension via an API call with a Boolean field indicating

whether the subscriber has activated their account. The journey should send activation reminder emails 24 and 48 h after creating an

account. The user exits the journey if they activate their account.

Which activities should be included in the customer&#8217;s journey?

*  24 hour Wait > Decision Split > Send Email > 24 hour Wait > Decision Split > Send Email

*  Decision Split > 24 hour Wait > Send Email > Decision Split > 48 hour Wait > Send Email

*  24 hour Wait > Decision Split > Send Email > 48 hour Wait > Decision Split > Send Email

*  Decision Split > 24 hour Wait > Send Email > Decision Split > 24 hour Wait > Send Email

QUESTION 104

Northern Trail Outfitters is noticing a gradual decline in the percentage of conversions per emails sent in their digital marketing

campaign. A new initiative is being adopted to reverse the trend What action should be taken to increase subscriber engagement?
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Choose 2 answers

*  Increase volume of emails to a wider audience.

*  Increase the use of dynamic content in emails.

*  Adopt a Cart Abandonment Email Campaign.

*  Introduce more identity verification steps in check out process.

QUESTION 105

n online retail customer needs daily promotional email content to generate with minimal time spent on creation. Their service

contract includes building a custom dynamic template for this purpose. The customer has communicated the following:

* The email content will highlight new inventory each day.

* A small team will run both their digital marketing operations and their email program.

* A user needs to build, test, and send a daily email in less than an hour.

* Images for the emails will be hosted on their website CMS.

Which question is relevant to identify strategies for designing the custom template for the customer&#8217;s daily promotional

email?

Choose 3 answers

*  Will image URLs be available publicly?

*  How often will the layout of the content in a content area change?

*  What is the maximum file size of the images being used?

*  How often will email content be image-only with text overlaying images?

*  What from name will be used for these emails?

QUESTION 106

A company collects subscriptions on its websites. It does the following:

* 	Compiles that subscription list in a database in the website content Management System (CMS).

* 	Posts this encrypted list to Marketing Cloud nightly at 11 p.m.

* 	Uses Marketing Cloud as the database of record.

* 	Sends up to five emails a week based on subscriber engagement with prior sends.

What automation sequence (excluding waits) should cover these requirements?

*  File Transfer > Import File > Measures > Send Email

*  File Transfer > Import File > SQL Query > Send Email

*  File Transfer > SQL Query > Measures > Send Email

*  File Transfer > Data Extract > Filters > Send Email

QUESTION 107
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For security reasons, Northern Trail Outfitters indicates they cannot store PII directly within their Marketing Cloud account. They

are considering implementing Tokenized Sending to pull PII from their data warehouse at send time. They indicate they send several

large, time-sensitive emails per year.

Which two considerations should be made about Tokenized Sending? (Choose 2 answers)

*  Journey Builder Decision Splits provide a method to access data of Tokenized data natively.

*  Personalization Strings still allow PII to be displayed within an email.

*  Service Level Agreements for email sends are unsupported with the inclusion of outside servers.

*  Tokenized Sending should be combined with field-level data encryption for additional security.

QUESTION 108

Which three statements are correct about Data Designer? Choose 3 answers

*  Each attributes group can contain multiple data extensions, and each data extension can include multiple attributes.

*  Data extensions can be linked to either the contact record or different data extensions, including data extensions from other

attributes groups.

*  Each attributes group contains one data extension, and each data extension can include up to 50 attributes.

*  Data extensions should be linked directly to be contact record prior to being linked to different data extensions.

*  Each attribute group can contain multiple lists, and each list can include multiple attributes.
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